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The manual you are holding in your hands (or reading on your screen) is an excerpt of the standard 
Traffic Studio user manual for the complete ITS4mobility system. 

 

 Note: The chapters in this manual covering the tools and functionality that are not specific for the 
Waste handling monitoring/functionality, are basically unchanged from the standard manual. They 
show the available functions, but the screen shots taken from systems for public transport 
monitoring will of course differ from how the application will look set up for Waste  collection 
monitoring.   

 

 



 

Below is a simplified image of how ITS4mobility works. The application is connected to a central 
system with databases and functions for forecasts and other system processes. The central system is, in 
turn, connected to a communication system for transferring data to and from the vehicle and the 
GPRS signs. The other signs are connected with cables. The central system also provides forecasts to 
other systems using the internet / cellphone applications. The assignments are sent to the central 
system from stand-alone planning tools. 



 

 

This section covers the layout of the main window and the features that are common to the 
application’s tools. 

 

Note: If the application is unable to connect upon startup, a blank window will appear with 
the Menu Bar and the Function Bar. 

 

Note: If the application is configured to connect automatically upon startup, the main window 
will appear with all its different subdivisions. 

 

You must connect manually if the automatic connection to the central system is not active. 

Click on the icon  in the upper left corner of the ITS4mobility window (see below).  

If you only have one central system to select, the application will connect to it. If you have several 
alternatives, you can click on the black down arrow to open a menu showing all the systems.  

If you simply click on the icon, the application will select the system that was used the last time.  

 

 

You can also connect via the Menu bar File > Connect 

 

The connection status is shown in the right bottom corner of the main window. 

 

 

 

 

 A visible red cross  means that the application is not properly connected to the central 
system, i.e. it cannot reach one or many databases. Click on the black down arrow to open up a 
list with all the databases and their connection status. 

 A visible green check  shown with the system name means that the application is properly 
connected to the central system. 



 

 

Traffic Studio is a modular application with number of separate but interconnected tools contained in 
a flexible framework. The various parts of the framework is presented below. 

Note that the user interface may vary depending on the configuration of the bars and the tool 
windows in your application. 

  

 

 In the example below the left tool window contains the Search Vehicle tool, the top window 
contains the Map (tiled) tool, and the bottom window contains The Active Vehicles and Reeport 
Points tool. 
  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 The Menu bar is explained in chapter 4 Menu Bar, p.12. 

 The Function bar is explained in chapter 5 Function Bar, p.17. 

  



 

The vehicle counter is located in the lower right corner of the application framework, between the user 
and the connection status. 

It shows the user’s active vehicles and the total of active vehicles. The numbers can differ if the user 
does not have the right to access the information of all the currently active vehicles. 

A small pie chart is located to the right of those numbers. Holding your mouse pointer over any part 
of the vehicle counter will open a larger view of the pie chart (see below). 

 

 

 

 

 

 

Click on the connection status field to expand the connection status pane. Here, all connected 
services/servers are listed with color coded status symbols. A green connection symbol/dot indicates 
an OK connection. A red symbol indicate a not OK status. Contact your system 
administrator/support if the pane show any red status indicators. 

 

 



 

 

Many tools can be open at the same time in the tool windows. These tools are selected using the tabs. 
Clicking on the corresponding tab activates the tool. An active tool tab is dark gray while all inactive 
tool tabs are a lighter shade of grey. To close the tool, click on the tab’s cross (see below). 

 

The administrator can disable the closing crosses for the tool tabs. This function is found in the 
configuration menu of the application. If the closing cross is disabled, the tool cannot be closed by the 
user. 

 

 

 

The left and bottom tool windows can be minimized to give the Top tool window, such as the map, as 
much place as possible on the screen.  

Click on the button located in the corner of the window area (see below) to minimize it, and again to 
expand it to its original size. The button has an arrow indicating the direction in which the window is 
minimized/expanded. 
 

      

Toggle Screen allows you to quickly and easily move tools between monitors if you are using two 
connected monitors.  

Right-click on a tool tab (see below) and then click on Toggle screen. The tool will be moved to the 
other monitor and will retain its relative position.  

 

 

Some tools, such as Vehicle History and Stop Point History, allow you to copy their content and paste 
them in other programs such as Excel. 

 Select a row by clicking on it, or select many rows with the use of SHIFT and CTRL. Selected 1.
rows are highlighted in blue (see image below). 

 Press CTRL + C to copy the content. 2.

 Open the program of your choice, e.g. a new sheet in Excel. 3.

 Press CTRL + V to paste the content. 4.



 

 

 



 

 

This section explains the Menu bar, its various options and their submenus. The Menu bar is found in 
the left upper corner of the application window.  

 

 

 

You find common settings and features in the File menu. 

 

 

Select this menu item to connect the application to the central system. You can also select to which 
system you want to connect (e.g. Gothenburg and Goiania) if several systems are configured. 

 

This will disconnect the application from the central system. 

 



 

 

 To access the setup menu, the application must be disconnected from the central system. This is 

achieved by clicking on the Disconnect button in the Function bar or via File > Disconnect. 
You can reconnect the application to the central system when you are done with the setup. 

 

 

This function is only available to the administrator. See the Administrator manual for more 
information. 

 

This function is only available to the administrator. See the Administrator manual for more 
information. 

 

This function is only available to the administrator. See the Administrator manual for more 
information. 

 

Complex configuration functionality. See the standard Traffic Studio User Manual. 

 

Individual tools: Assignment, Traffic Information, Customer Support, Map, etc. have individual setup 
sections in the menu. Depending on the tool, these are described in the individual tool chapters in 
section 9 Tools or in the separate Administrator manual. 

 



 

Reset the setup to the default/factory setup, i.e. the application will return to its setup when the 
program was installed, including the group’s default settings. 

 

Close the File menu. 

 

Print the content of the active tool.  

 

 Note: Print functionality is only available in some tools. The button will be greyed out when this 
functionality is not available. 

 

Selecting Print will open up the window Print preview where you can select what will be printed and 
on how many pages the image will be printed. 

 

 

 

 

 

 

 

 

 

 

Open the default Windows printer setup where you can select paper size and set up the printer. See the 
Windows user’s guide and printer documentation. 

Exit the application. 

 

Export the data to an Excel file.  



 

 

Offer the options to show/hide the Function bar, select full-screen display for the application and 
enable the support for a secondary monitor. 

 

 

The tools menu displays all the available tools at your disposal in the application. The tools are 
presented hierarchically in the menu. 

Depending on the configuration, the tool menu can look different from the one shown below (e.g. 
different order for tool and different available tools.). The individual tools are described in chapter 7.  

  



 

 

The Help function provides information about the version of the application and various plug-ins 
(tools, etc.). Select Help > About in the Function bar to open the window About.  

 

If the option Context help is active, your system will be able to display context help for Traffic 
Information. In this case, a new Winhelp-window will be opened with helpful information about the 
traffic information tool. 

 

 

 

 

 

 

 

You can select the language for all the menus and functions in the application.  

 

After selecting another language, a window will pop up requesting you to confirm your new selection 
(see below). Confirm by clicking on Yes and cancel by clicking on No. 

If you accept the changes, the application will automatically disconnect from the central system to 
change the language and it will restart by itself after a few seconds. 

 



 

 

The Function bar comprises buttons and text fields granting a quick access to selected features 
(depending on the configuration), functions and tools. 

 

The Function bar is easily configurable. Its components can be moved or sorted in the order of your 
choice.  

 

 

 

 

 

 

 

 

To move a component, take hold of the dotted “handle” and drag it where you want to have it. For 
example, you can move it to the bottom of the main page (see below). 

 

 

 

 

On the left side of the Function bar, you usually find a series of buttons that are not related to a 
specific tool. 

 

 

 

 

 



 

 

 

With the function bar filter Show my vehicles only you can exclude all vehicles from other operators 
by simply pressing the tool button. The button is highlited whenever the function is active (see below). 

 

 

 

 

 

 

Line groups are not used in the Sudbury Waste system, even if the tool is present in the function bar. 

 

 

 

 

 

how 

my vehciles only filter. 



 

 

This section focuses on the shared display options and features used by the tools in the ITS4mobility 
application. 

 

In many tools vehicle position and status is indicated with color coded icons for various vehicle types 
(see example below).  

 

 

 

Different types of vehicles are normally presented with corresponding icons, see below. 

     

 

 

The vehicle icon color code normally indicate both the punctuality (vehicles servicing a line with a 
timetable) and the service state of the vehicle. As waste trucks do not run a time table, they will always 
be color coded grey. 



 

Tooltips are information boxes that are displayed when you hold your mouse pointer over an object in 
one of the tools. The information in the tooltip can be configured/customized to fit your needs. See 
the standard Traffic Studio user manual for how to configure tooltips and labels. 

 

 

 

The vehicle icons can, optionally, be supplemented with labels including information such as vehicle 
number etc. The vehicle label is configured in the same way as the tooltips. The difference is that the 
labels are displayed at all time and not only when the mouse pointer is held over a vehicle symbol, a 
reason why the label should not contain too much information.  

 

 

 



 

 

Right-clicking on a vehicle symbol will open a shortcut menu for that vehicle with links to other tools 
and information windows. 

Note: The content of the shortcut menu depends on the installed toolset. For waste truck 
monitoring, this menu will be much reduced with only a few menu items available. 

 

You can also reach the shortcut menu for the closest stops on the serviced route by selecting Last and 
Next (stop). 

 

 

 

The vehicle history window provides instant access to the basic information included in the logged 
vehicle reports from the selected vehicle. 

Sort the history by clicking on the column headers. You can also sort columns horizontally by dragging 
the column headers left/right. 

 

 

 



 

 

You can copy information and paste it in other software, such as Excel, Word, etc. Select one or many 
rows with SHIFT and/or CTRL. Once selected, use the keyboard shortcut for “copy”, which is 
CTRL+C. Open your software of choice and paste the information (CTRL+P). 

 

Opening the history of a vehicle also displays its trail, in green, on the (tiled) map. It also shows all its 
reports as small dots. 



 

 Use the previous and next buttons to navigate through the history and update the trail on the 
map. 

 Double click on a row in the History window to view the particular vehicle event on the 
map (highlighted orange). 

 

 

 

To make the vehicle trail as correct as possible, “gaps” in the vehicle reports are plotted as dashed 
straight lines. These are trail sections where there is too little information to plot the actual driven 
route with confidence. Gaps can occur where for technical reasons vehicle reports are missing. 

The trail lines are dashed wherever the distance between reports are greater than a set threshold, or the 
time between reports are more than the configured threshold. (See chapter 8.3 for information about 
this configuration.) 

 

 

 

 

Show a close-up view of the vehicle in its own map window (a new map tab is created with the vehicle 
ID in its heading). If a black crosshair is shown (see below), the displayed position is based on the GPS 
data sent from the vehicle.  



 

When you select a vehicle to be followed, an new map/tiled map tab will open, zoomed in on that 
vehicle. The vehicle icon on the map will be surrounded by a circle indicating that the vehicle is being 
followed. If the position is based on GPS data from the vehicle the vehicle symbol will also be 
displayed with a cross/crosshairs. A heading arrow indicates the latest reported heading. 

 

 

 



 

 

The tools give the application its functionality. In this chapter, we will go through all the available tools 
and their settings. 

 

 

Note: Your access to other companies vehicles may be limited. When inaccessible, the data will be 
replaced by “???” to indicate that it is not available. The shortcut menus of these vehicles will also offer 
a limited functionality. This is done to protect each operator’s information. 

  



 

 

The Report Point tool is used for viewing planned and imported report points. The adresses and 
planned number of units to be collected can be viewed  in table form. The report point geographical 
positions can be viewed using the map tool. 

Two lists are used for quick navigation: A list to the left shows all routes, and a list to the right shows 
all report points, in the route you selected in the left list. Separate free text filters  

 

The report point tool consists of two lists, one covering all imported “routes”, and one listing all 
report points of the route you selected in the left list. 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

If the routes list is long you can filter it to make it more manageble. Simply enter the desired filter 
content in the free text filter field and click on the filter button (the looking glass button). 

 

 

 



 

The report points lis is normally quite long and here the free txt filter can be of much use. You can 
enter street names and even report points with certain number of planned units to collect, to filter the 
list. 

 Note: In this version of the tool the map shows all report points of the selected route, regardles of 
how you filter the report point list. 

 

 

You can highlight and zoom in on any report point in the report point list simply by clicking on the 
corresponding row in the report point list. 

 



 

 

Locate a vehicle or a block in the system by typing in their number or part of their number. Clicking 
on search will list all the vehicles/blocks with the search criteria in their number will be listed (Ex. 3 
will show vehicles such as 3, 103, 131, 302, etc.).  

The results will list both active and historical vehicles (vehicles that have completed their routes). The 
vehicles are sorted according to their last report. Active vehicles are listed with the most recent report 
first. Historical vehicles are listed the opposite way, with the vehicle with the oldest report as the first 
in the list. 

You can select the time interval for active/historical vehicles in the Vehicle setup tool under the 
Presentation tab by entering values for “Ignore messages older than <date>”. See chapter Vehicle 
Presentation for more information. 

 

To search after a vehicle or a block: 

1. Enter all or parts of the vehicle number or block number. 

2. Click on Find. 

All the vehicles fitting the criterion, at least partially, are listed. The top of the list shows the active 
vehicles while the lower part shows the historical vehicles. 

 

 

 

 

 

 

 

Right-clicking on a vehicle in the Search Vehicle tool window will open the vehicle shortcut menu, 
see chapter 6.1 

 

  



 

 

The Map tool gives a geographical overview of a particular area (It uses OpenStreetMap for its 
geographical visualization). 

The Map tool has many uses. The selection tools, for instance, lets you select on the map the info 
point for traffic information (see New Traffic information Tool). The function Follow vehicle allows 
you to follow a vehicle on the map. You can of course also directly access shortcut menus for vehicles 
and stop points via the map. See chapter 6 Tooltips, Shortcut Menus and Icons, p.19 for more 
information. 

The map settings are explained in detail in the administrator manual. 

 

 

 

 

 

There are many available functions for the map that are at the disposal of the user. These functions 
and their symbols are described below. 

 

 

 

 

 

 

  

 

 

or



 

 

The map view also has a coordinates bar in its lower part showing the coordinates of the mouse 
pointer in the map. These values are described in the map coordinate system. 

 

 

To focus the map view on whats important to you, map “object” types like stops, vehicles, plotted 
routes etc can be shown/hidden, per type, using the map object palette. This palette, in turn, is 
displayed/hidden using the Map object Palette button in the bottom right corner of the Tiled Map tool 
window, see below. 

For information about information display map layer, see the Traffci Information chapter. 

For information about route layers, see the chapters covering the Planned Traffic and Route Checker 
tools. Different route types/link status plots can also be viewed/hidden individually. This function is 
presently only used by our Snow Plow Monitor function, see the corresponding chapter. 

 

 

 

 

 

 

 

 

 

 

 



 

 

The stops are shown with these symbols:  . The orange color means that the stop is 
selected. 

Note that the vehicle and stop point symbols give direct access to many tools via their shortcut menus. 



 

 

 

The Active Vehicles tool shows the real time status of all the vehicles considered active by the system, 
i.e. the vehicles that have been reporting within a predetermined time. The settings for this time period 
is based on the one found in Vehicle Presentation.  

The listed vehicles can also be filtered with the Line Group tool, by company, by interval and with the 
use of the free text Filter/search field. 

Active Vehicles includes an expandable bar chart displaying the number of communicating vehicles by 
15 minutes intervals during the calendar day. 

 

Active Vehicles provides detailed information about all active vehicles (those reporting within a given 
time interval). The list can be sorted after each column by clicking on its header.  

Every time the list is updated, the new information is highlighted in bright yellow (see image below). 

 

 

 

 



 

 

You can filter the information by various means to adapt the list view to your needs and/or make it 
easier to read, see below. 

 

Click on the “Show my vehicles only” filter button (in the function bar) to only view vehicles 
belonging to your own company. 

 



 

You can choose to show all vehicles (according to the filters mentioned above) or only the vehicles of 
one selected company. Select it via the company drop-down menu. 

 

 

Active Vehicles by default lists all the active vehicles for a predetermined time interval, e.g. all vehicles 
that have sent a report in the last 30 minutes. You can select a shorter interval in the drop-down menu 
to filter the list to only include vehicles having sent a report in the last 5, 10, 15, 20 or 25 minutes. 

 

 

The free text field filters the data displayed in the list. Every cell matching the filter content is 
highlighted grey to make them easier to notice. Only the rows with matching cells are included in the 
list. 

The list is automatically updated as you enter information in the filter field.  

 

 

  



 

Click on the looking glass symbol to activate the column specific filter function. Separate search fields 
for each searchable column will appear. Enter search text/digits in one or more column fields to filter 
the list. Only matching lines will be included, but the matching cells will not be highlighted gray. Click 
again on the looking glass symbol to deactivate/hide the column search fields. 

 

Note that the column specific filters can be used together with the regular free text filter. 

 

  

The bar graph is minimized by default. Click on the chart button to show the graph above the vehicle 
list in the Active Vehicles tool.  

 

 

The bar graph shows the number of of vehicles, both assigned and unassigned, that are 
communicating. Each bar represents an interval of 15 minutes, for the current calendar day (00:00 to 
23:58).  

The horizontal red line indicates the current time. Its position is updated as time passes and the graph 
gets another 15.minute bar. 

 



 

Hold the mouse over a bar to get a tooltip showing the total amount of reports, followed by its 
repartition in each category (AMS and NVS). 

 

 

 AMS reports are related to positions, door opening, deviations, etc. Most reports are in this 
category. 

 NVS reports are related to the vehicle asking the depot about its software version. 

 



 

 

 

The My Vehicles tool lists all available static vehicle information for the vehicles in a system. This can 
include everything from chassis ID to Wheel chair capacity to Manufacturing date. The tool includes a 
company and a free text filter for narrowing down the presentation and functions for sorting the 
content. 

 

Note: The column order can be set by dragging and dropping the columns. 

 



 

 

 

 



 

To only view the vehicles of a particular company, use the Company filter: When the filter field is 
blank all vehicles in the system is included in the list. 

 

 

To narrow down the presentation you can apply a free text filter. Only rows with one or more matches 
will be included in the list.  

 

Click on the looking glass symbol to activate the column specific filter function. Separate search fields 
for each searchable column will appear. Enter search text/digits in one or more column fields to filter 
the list. Only matching lines will be included, but the matching cells will not be highlighted gray. Click 
again on the looking glass symbol to deactivate/hide the column search fields. 

 

Note that the column specific filters can be used together with the regular free text filter. 

 

 

Click on a column head to sort the list after the column content. The column head will be highlighted 
and a Sorting direction indicator will show the sorting direction. Click again on the column head to 
sort the list after the column content - in reverse order. 



 

 

 

The vehicle list can be large hard to read with so many columns and so much information. To 
highlight a chosen vehicle row in the list, simply click on the row. 

 

 

 

  



 

 

The Vehicle Groups tool lets you create groups of vehicles, which can be used, for example, to make 
group calls in the Voice Communication tool. 

 

The Vehicle Groups tool window consists of three sections. 

 Left section: List of all current vehicle groups. 

 Central section: Editable fields for the selected (or a new) vehicle group. 

 Right section: List of all vehicles available for inclusion in a group. 

 

Note: Vehicles can belong to more than one group.  

 

 

 

 

 

 

 

 

The search field filters the data displayed in the list. Every cell matching the filter content is highlighted 
in grey to make them easier to notice. Only the rows with matching cells are included in the list. 

The list is automatically updated as you enter information in the filter field.  

  

group name description



 

To add/remove a vehicle to/from, an existing group:  

 You can double-click on a vehicle or select it and use one of the arrows. 

 To make a multiple selection, use SHIFT and/or CTRL, then click on the appropriate arrows.  

 

 Click on the New button. 1.

 

 Enter the information under Group Details, such as Name and Description. 2.

 

 Select the group’s company via the drop down menu. The list of vehicles will be generated in the 3.
Available Vehicles list. Note that once the group is saved, the company menu is locked. 

 

 Select the vehicles in the Available Vehicles list. You can double-click on a vehicle to select and 4.

move it to the group, or select it and then use the upper arrow  to move it. To make a 



 

multiple selection, use SHIFT and/or CTRL to select several vehicles in the available vehicles list, 

then click on the upper arrow  to move them to the group. You can of course always remove 
a vehicle, or many, from the Selected Vehicles list. 

 

 Click on Save to save your group. The blue row will update with the group information. Click on 5.
Cancel to end the group creation. 

 

 

 Select a group in the Vehicle Groups list. Its properties appear in the Group Details window, 1.
including its name, description and selected vehicles. Note that you cannot modify the company 
associated to the chosen vehicle group.  

 Modify the name, description or add/remove vehicles. 2.

 Click on Save to keep the changes or click on Cancel to continue without modification. 3.

 

 Select a group in the Vehicle Groups list. Its properties appear in the Group Details window. 1.

 Click on Delete to remove it from the list. Note that you will not be asked to confirm the deletion, 2.
nor can you undo it. 
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